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Utilisation de l’Utilitaire 
de réponse d’impulsion

 

L’Utilitaire de réponse d’impulsion est une application de déconvolution et d’enregistre-
ment audio multipiste. Il vous permet de créer vos propres réponses d’impulsion mono, 
stéréo et Surround pour Space Designer, l’effet de réverbération à convolution de 
Logic Studio. 

Tous les paramètres et toutes les fonctions dont vous avez besoin pour créer des réponses 
d’impulsion sont réunis dans un même écran. 

L’interface de l’Utilitaire de réponse d’impulsion est divisée en quatre zones :
Â

 

Zone Hardware I/O Assignment :

 

  comprend des menus locaux permettant de sélec-
tionner l’entrée et la sortie audio.

Â

 

Section du Monitor and Sweep Generator :

 

  offre des paramètres de monitoring et de 
génération de balayage sinusoïdal, ainsi que des boutons permettant de déconvoluer 
vos pistes audio en une réponse d’impulsion et d’écouter cette dernière.

Â

 

Section Inputs/Track :

 

  répertorie toutes les pistes audio utilisées pour vos enregistre-
ments de réponse d’impulsion.

Â

 

Zone Editing :

 

  affiche les informations audio de la piste audio sélectionnée.
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La 

 

déconvolution

 

 est le processus utilisé pour créer des réponses d’impulsion à partir de 
balayages sinusoïdaux audio à large bande (enregistrés). La rubrique ci-dessous traite de la 
déconvolution et de son rôle dans le processus de création des réponses d’impulsion. Les 
rubriques suivantes présentent le matériel nécessaire à l’enregistrement des réponses 
d’impulsion et expliquent comment utiliser l’Utilitaire de réponse d’impulsion pour créer 
vos propres fichiers de réponse d’impulsion Space Designer (.sdir).

 

La déconvolution et l’Utilitaire de réponse d’impulsion

 

Space Designer combine, ou 

 

convolue

 

, la réponse d’impulsion d’un espace acoustique 
avec un signal audio. Cela a pour effet de placer votre audio « dans » l’espace acoustique, 
représenté par cette réponse d’impulsion. Une réponse d’impulsion peut être vue 
comme la somme des échos (réflexions) produits dans un espace physique donné après 
le pic initial d’un signal. Le fichier de réponse d’impulsion est en fait un enregistrement 
audio réalisé dans un espace contenant ces échos. 

 

Enregistrement d’une réponse d’impulsion

 

Deux méthodes pratiques peuvent être utilisées pour enregistrer une réponse 
d’impulsion. 

 

Utilisation d’un enregistrement d’élément transitoire

 

La première méthode consiste à enregistrer une impulsion dans un espace à l’aide, 
par exemple, d’un pistolet de starter. Le coup de feu constitue l’impulsion, et le fichier 
audio que vous enregistrez capture à la fois cette impulsion et la réponse de la pièce. 

L’avantage de cette méthode est que le fichier audio enregistré peut être utilisé dans 
Space Designer sans être traité auparavant. Vous pouvez utiliser l’Utilitaire de réponse 
d’impulsion pour enregistrer les impulsions de votre pistolet de starter, puis les combi-
ner dans un fichier de réponse d’impulsion Space Designer (.sdir) (et un fichier de 
réglage Space Designer).

L’inconvénient de cette méthode est qu’il est extrêmement difficile de réaliser un enregis-
trement parfait de coup de feu sans distorsion. Cela s’explique par la très forte intensité 
sonore de l’élément transitoire initial du coup de feu. L’autre problème est que les coups 
de feu d’un pistolet de starter contiennent très peu d’informations de basse ou haute fré-
quence, ce qui limite la plage de fréquences utilisable de la réverbération convoluée. 
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Utilisation d’un balayage sinusoïdal à large bande

 

La seconde méthode (recommandée) permettant de créer des réponses d’impulsion con-
siste à lire un balayage sinusoïdal audio à large bande dans un espace et à enregistrer ce 
balayage (ainsi que la réponse de l’espace) à des niveaux d’enregistrement optimaux. Un 
balayage sinusoïdal couvrant la totalité de la plage de fréquences audible est utilisé, ce 
qui permet d’obtenir une réponse d’impulsion bien souvent de meilleure qualité avec 
une plage de fréquences étendue. 

Le fichier audio du balayage sinusoïdal enregistré ne peut pas être utilisé directement 
comme réponse d’impulsion. Il contient en effet tous les échos et toutes les réflexions, 
c’est-à-dire la 

 

réponse

 

, de l’espace, et ce sur toute la longueur du balayage sinusoïdal, ce 
qui est très différent de l’approche avec le pistolet de starter, où la 

 

réponse

 

 est contenue 
au début du fichier dans une 

 

impulsion

 

.

Lorsque vous utilisez un balayage sinusoïdal, l’Utilitaire de réponse d’impulsion utilise un 
processus appelé 

 

déconvolution 

 

pour réaliser un alignement temporel et de niveau de 
toutes les réflexions enregistrées, qui sont présentes sur la 

 

totalité

 

 du balayage sinusoïdal 
enregistré, au tout début du fichier. Cela produit une réponse d’impulsion que Space 
Designer peut utiliser pour combiner, ou convoluer, avec votre signal audio. L’Utilitaire 
de réponse d’impulsion peut ensuite générer un fichier de réglage .sdir à partir de cette 
réponse d’impulsion.

 

Configuration de votre système d’enregistrement 
de réponse d’impulsion

 

Avant de pouvoir utiliser l’Utilitaire de réponse d’impulsion pour créer une réponse 
d’impulsion, vous devez configurer votre matériel d’enregistrement pour qu’il puisse lire 
et enregistrer le balayage sinusoïdal généré par l’Utilitaire de réponse d’impulsion.

Dans l’idéal, vous devez disposer des éléments suivants :
Â

 

Un haut-parleur pour chaque emplacement (de haut-parleur) requis par le format choisi, 
si vous prévoyez de générer des balayages d’onde sinusoïdale. Exemples :  si vous enre-
gistrez une vraie réponse d’impulsion stéréo, il vous faut deux haut-parleurs. Si vous 
enregistrez une réponse d’impulsion Surround à six canaux, il vous en faut six, etc. 
Si vous ne générerez pas de balayages d’onde sinusoïdale, vous n’avez pas besoin de 
haut-parleurs pour les lire (le son est généré par le pistolet de starter).

 

Remarque :  

 

dans la plupart des cas, vous pouvez vous contenter d’enregistrer 
une seule position de haut-parleur (mais toutes les positions de micro requises par 
le format de réponse d’impulsion choisi) et de créer une réponse d’impulsion discrète 
mono/omni. Cela permet d’obtenir une réponse d’impulsion nécessitant moins de 
puissance de l’unité centrale dans le format requis. Voir « Enregistrement d’une 
réponse d’impulsion à 5 canaux Mono vers Omni » à la page 33.



 

6

Â

 

Un ou plusieurs micros pour enregistrer l’audio résultant produit par chaque haut-
parleur (ou par le coup de feu) combiné avec ses échos/réflexions. Le nombre de 
micros dont vous avez besoin dépend du format de réponse d’impulsion choisi. 
Exemples : si vous enregistrez une réponse d’impulsion Surround à six canaux, 
il y a six positions de micro, vous devez donc dans l’idéal disposer de six micros. Si 
vous enregistrez une réponse d’impulsion encodée au format B à six canaux, pour 
laquelle une seule position de micro et quatre pistes sont nécessaires, il vous en faut 
moins, etc. Voir « Encodage Surround au format B » à la page 29 pour en savoir plus.

Â

 

Une interface audio dotée de suffisamment de sorties pour envoyer un balayage sinusoï-
dal audio à large bande à chaque haut-parleur (en cas d’utilisation de balayages sinusoï-
daux) et de suffisamment d’entrées pour enregistrer l’audio résultant de chaque position.

 

Remarque :  

 

vous pouvez également avoir besoin de préamplificateurs de micro supplé-
mentaires si vos micros ne sont pas en mesure de capturer un signal suffisamment fort 
ou si votre interface audio ne dispose pas d’assez d’entrées avec préamplificateur de micro.

Il est possible de créer des réponses d’impulsion multipiste discrètes, même si vous 
n’avez pas suffisamment de haut-parleurs ou de micros. Dans la mesure où vous n’enre-
gistrerez qu’un seul balayage sinusoïdal à la fois, vous pouvez installer les haut-parleurs 
dont vous disposez, les enregistrer dans l’Utilitaire de réponse d’impulsion, puis les pla-
cer sur de nouvelles positions et répéter la procédure. Imaginez par exemple que vous 
n’ayez qu’une seule paire de haut-parleurs stéréo, mais que vous souhaitiez créer une 
réponse d’impulsion quadriphonique, ce qui nécessite l’enregistrement de quatre pis-
tes dans quatre positions de haut-parleur différentes. Vous pourriez dans ce cas instal-
ler votre paire de moniteurs, enregistrer leur sortie, puis les déplacer pour enregistrer 
l’autre paire de pistes dans les deux autres positions de haut-parleur. 

Exemple de haut-parleurs et de micros configurés pour la capture d’une réponse d’impulsion 

Ordinateur

Interface audio
Système 

de micros 
Surround

C
RL

RsLs
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Cette méthode de création de réponses d’impulsion prend évidemment plus de temps, et 
le fait de ne pas pouvoir installer tous vos haut-parleurs en même temps rend leur posi-
tionnement optimal l’un par rapport à l’autre difficile. Avec du temps et une planification 
minutieuse, vous pouvez toutefois obtenir les mêmes résultats.

∏

 

Astuce :

 

  vous pouvez également créer des réponses d’impulsion à plusieurs canaux 
dans l’Utilitaire de réponse d’impulsion en utilisant le format « Mono to Omni Discrete ». 
Ce format ne nécessite l’enregistrement que d’un seul haut-parleur par autant de micros 
« canal » que nécessaire (pour le format choisi). La réponse d’impulsion obtenue nécessite 
moins de puissance de l’unité centrale. Voir « Enregistrement d’une réponse d’impulsion 
à 5 canaux Mono vers Omni » à la page 33.

Si vous avez suffisamment de moniteurs mais pas assez de micros, vous pouvez installer 
les haut-parleurs requis et vous contenter de déplacer les micros disponibles de l’un 
à l’autre. Cette méthode rend le positionnement optimal des micros l’un par rapport 
à l’autre difficile, mais vous conservez tout de même l’avantage du positionnement idéal 
des haut-parleurs (et il faut bien avouer qu’il est beaucoup plus facile de déplacer des 
micros que des haut-parleurs !).

Si votre interface audio n’offre pas suffisamment d’entrées et de sorties pour le nombre 
de haut-parleurs et de micros que vous utilisez pour créer votre réponse d’impulsion, 
vous pouvez tout de même installer tous les micros et haut-parleurs. Lors de l’enregistre-
ment des différentes pistes dans l’Utilitaire de réponse d’impulsion, vous devrez décon-
necter/reconnecter les haut-parleurs et les micros à tour de rôle.

Vous trouverez une présentation plus détaillée des haut-parleurs et des micros conve-
nant à la création des réponses d’impulsion, ainsi que des suggestions concernant leur 
positionnement, dans la rubrique « Recommandations relatives aux micros et haut-
parleurs » à la page 23.

 

Création de réponses d’impulsion dans l’Utilitaire 
de réponse d’impulsion

 

Les étapes nécessaires à la création d’une réponse d’impulsion dans l’Utilitaire 
de réponse d’impulsion sont les suivantes :

 

Étape 1 :  création d’un projet de réponse d’impulsion

 

Configurez votre projet Utilitaire de réponse d’impulsion pour le nombre de pistes 
nécessaire au format de réponse d’impulsion choisi.

 

Étape 2 :  définition des paramètres de l’Utilitaire de réponse d’impulsion

 

Définissez les paramètres d’entrée et de sortie matérielles, du moniteur et du balayage 
pour l’enregistrement de vos pistes audio.
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Étape 3 :  enregistrement

 

Utilisez l’Utilitaire de réponse d’impulsion pour enregistrer les pistes audio nécessaires à 
votre réponse d’impulsion.

 

Étape 4 :  déconvolution de vos enregistrements audio

 

Si vous avez enregistré des balayages sinusoïdaux, cliquez sur Déconvoluer une fois toutes 
les pistes audio enregistrées. L’Utilitaire de réponse d’impulsion génère alors une 
réponse d’impulsion à partir de vos pistes.

 

Étape 5 :  édition et écoute

 

Coupez les parties de silence, appliquez des fondus, etc., pour optimiser votre réponse 
d’impulsion.

 

Étape 6 :  création d’un réglage Space Designer

 

Cliquez sur « Create Space Designer » une fois toutes les étapes ci-dessus terminées. Cela 
ajoute la réponse d’impulsion créée à votre liste de réglages Space Designer disponibles.

Les sous-rubriques suivantes décrivent chaque étape en détail.

 

Création de votre projet

 

Lorsque vous ouvrez l’Utilitaire de réponse d’impulsion pour la première fois, la zone de dia-
logue « New Impulse Response Project » s’affiche. Il s’agit de la première étape de la 
création d’un projet de réponse d’impulsion. Vous pouvez également créer un projet en 
choisissant File > New Project (ou en appuyant sur Commande + N).

L’Utilitaire de réponse d’impulsion propose divers formats allant des formats convention-
nels stéréo, véritable stéréo (où chaque canal est traité individuellement) et quadriphoni-
ques, aux formats Surround à cinq, six ou sept canaux. Ces derniers peuvent être de deux 
types :  multipiste standard ou avec encodage au format B. Voir « Encodage Surround au 
format B » à la page 29 pour en savoir plus.

Vous pouvez également créer des réponses d’impulsion à plusieurs canaux dans 
l’Utilitaire de réponse d’impulsion en utilisant le format « Mono to Omni Discrete ». 
Ce format ne nécessite l’enregistrement que d’un seul haut-parleur par autant de micros 
« canal » que nécessaire (pour le format choisi). La réponse d’impulsion obtenue nécessite 
moins de puissance de l’unité centrale. Voir « Enregistrement d’une réponse d’impulsion 
à 5 canaux Mono vers Omni » à la page 33.
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Pour créer un projet de réponse d’impulsion :
1

 

Choisissez le format de réponse d’impulsion souhaité dans le menu Configuration.

Dans la fenêtre située sous le menu Configuration, la zone de dialogue affiche le nombre 
de positions de haut-parleur et de micro requis par le format sélectionné.

 

2

 

Cliquez sur OK.

La zone de dialogue « New Impulse Response Project » se ferme et le nombre de pistes 
requis (déterminé par le format choisi) s’affiche dans la section Inputs/Tracks.

 

Définition des paramètres de l’Utilitaire de réponse 
d’impulsion

 

Après avoir créé un projet de réponse d’impulsion, vous devez assigner le périphérique 
d’entrée et de sortie audio et définir les réglages du moniteur et du générateur de balayage.

 

Assignation du matériel d’entrée et de sortie

 

Vous devez configurer le périphérique d’entrée et de sortie audio dans la zone « Hardware 
I/O Assignment » avant de pouvoir utiliser l’Utilitaire de réponse d’impulsion. 

La sélection de l’entrée audio détermine le périphérique audio utilisé pour enregistrer 
les pistes audio. La sélection de la sortie audio détermine le périphérique audio utilisé 
pour contrôler le signal enregistré et lire le balayage sinusoïdal généré.

 

Pour sélectionner un périphérique d’entrée audio :
m

 

Dans le menu Audio Input, choisissez le pilote d’interface audio souhaité.

 

Pour sélectionner un périphérique de sortie audio :
m

 

Dans le menu Audio Output, choisissez le pilote d’interface audio souhaité.

 

Modification de la fréquence d’échantillonnage

 

La zone « Hardware I/O Assignments » affiche également la fréquence d’échantillonnage 
actuelle. Vous ne pouvez pas modifier la fréquence d’échantillonnage de votre projet de 
réponse d’impulsion dans l’Utilitaire de réponse d’impulsion. Si vous souhaitez enregistrer 
vos pistes audio à une autre fréquence d’échantillonnage, vous devez la modifier dans 
l’utilitaire Configuration audio et MIDI ou dans le logiciel de votre interface audio (le cas 
échéant). En cas de doutes, reportez-vous à la documentation de votre interface audio.
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Configuration des commandes du moniteur

 

Après avoir enregistré des pistes de balayage sinusoïdal dans l’Utilitaire de réponse 
d’impulsion, vous pouvez les contrôler via la sortie stéréo de votre choix. Les commandes 
du moniteur déterminent le canal et le niveau de ce dernier. Vous pouvez également 
désactiver le son de la section du moniteur.

 

Pour sélectionner les canaux de sortie du moniteur stéréo :
m

 

Choisissez la paire de sorties stéréo souhaitée dans le menu Monitor Channel.

 

Pour ajuster le niveau de sortie du signal contrôlé :
1

 

Cliquez dans le champ Monitor Level.

 

2

 

Effectuez l’une des opérations suivantes :

Â

 

Faites glisser le pointeur vers la gauche (ou le bas) pour réduire le volume ou vers 
la droite (ou le haut) pour l’augmenter.

Â

 

Saisissez une valeur numérique pour le niveau du moniteur (toute valeur supérieure 
à 0 dB règle le niveau du moniteur sur 0 dB).

 

Important :  

 

pour éviter l’effet de Larsen pendant l’enregistrement, veillez à désactiver 
le son de la sortie du moniteur.

 

Pour désactiver le son de la sortie du moniteur :
m

 

Cochez la case Monitor Mute.

 

Configuration du générateur de balayage

 

Le générateur de balayage produit une onde sinusoïdale balayant progressivement 
la plage de fréquences de 20 Hz à 20 kHz. Les paramètres du générateur de balayage 
définissent la sortie matérielle, le volume, la longueur, le temps de réverbération et le 
pre-roll du balayage sinusoïdal.
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Pour définir le canal de sortie matérielle du balayage sinusoïdal :
m

 

Choisissez le canal de sortie souhaité dans le menu Sweep Channel.

 

Pour définir le niveau de sortie du balayage sinusoïdal :
1

 

Cliquez dans le champ Sweep Level.

 

2

 

Effectuez l’une des opérations suivantes :

Â

 

Faites glisser le pointeur vers la gauche (ou le bas) pour réduire le volume ou vers 
la droite (ou le haut) pour l’augmenter.

Â

 

Saisissez une valeur numérique pour le niveau du balayage (toute valeur supérieure 
à 0 dB règle le niveau du balayage sur 0 dB).

 

Longueur du balayage

 

Trois options de longueur sont disponibles pour le balayage sinusoïdal :
Â

 

10 s :

 

  balayage sinusoïdal de dix secondes.
Â

 

50 s :

 

  balayage sinusoïdal de cinquante secondes.
Â

 

Désactivé :

 

  aucun balayage sinusoïdal. Choisissez ce réglage si vous enregistrez 
une impulsion de pistolet de starter.

Dans l’idéal, l’onde sinusoïdale doit être courte. Cela permet d’éviter les artefacts dus au 
déplacement d’air, au bruit de la pièce et aux autres bruits ambiants dans votre enregis-
trement. Un balayage sinusoïdal de 10 secondes est donc un choix judicieux. Malheureu-
sement, les balayages courts peuvent ne pas produire un rapport signal/bruit suffisamment 
élevé dans certaines situations d’enregistrement. Si vous estimez que les résultats obtenus à 
partir d’un enregistrement de 10 secondes ne sont pas satisfaisants, essayez avec une durée 
de 50 secondes.

 

Pour définir la longueur du balayage sinusoïdal :
m

 

Choisissez la longueur de balayage souhaitée dans le menu Sweep Length.

 

Reverb Time

 

Le paramètre Reverb Time détermine la durée d’enregistrement maximale de chaque 
piste. Pour capturer avec précision les propriétés acoustiques d’un espace, vous devez 
définir un temps suffisamment long pour capturer la phase de rétablissement de toutes 
les réverbérations et de tous les échos. 

Si vous utilisez le générateur de balayage, le temps de réverbération commence lorsque 
le balayage sinusoïdal se termine. Si vous avez réglé le paramètre Sweep Length sur 
Désactivé (en vue d’enregistrer la réponse d’impulsion d’un coup de pistolet de starter), 
le paramètre Reverb Time détermine la longueur totale de l’enregistrement.
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Pour définir le temps de réverbération :
1

 

Cliquez dans l’affichage Reverb Time.

 

2

 

Effectuez l’une des opérations suivantes :

Â

 

Faites glisser le pointeur vers la gauche (ou le bas) pour réduire le temps 
ou vers la droite (ou le haut) pour l’augmenter.

Â

 

Saisissez une valeur numérique pour le temps de réverbération.

 

Preroll

 

Le but est de s’assurer qu’aucun bruit d’opérateur, tels que les bruits de frappe ou encore 
ceux dus au réajustement des micros, n’est enregistré. Pour ce faire, vous pouvez définir 
un preroll. L’enregistrement ne débutera pas immédiatement, ce qui vous laissera le 
temps de terminer la frappe, de corriger la position des micros au dernier moment si 
nécessaire, etc. La durée du preroll est identique à celle définie pour le paramètre Reverb 
Time.

 

Pour activer/désactiver le preroll :
m

 

Cochez la case Preroll.

 

Générateur de signal de test

 

L’Utilitaire de réponse d’impulsion inclut un générateur de signal d’onde sinusoïdale 
tenue (c’est-à-dire, sans balayage) intégré permettant d’étalonner vos sorties matérielles. 
Plusieurs fréquences sont disponibles :  100 Hz, 1 kHz, 5 kHz et 10 kHz. Utilisez ce signal de 
test pour vérifier que le canal de sortie matérielle est correctement connecté et que vos 
haut-parleurs peuvent reproduire la fréquence d’onde sinusoïdale sélectionnée. 

 

Pour définir la fréquence du signal de test :
m

 

Choisissez la fréquence souhaitée dans le menu Test Tone.

 

Pour activer/désactiver le signal de test :
m

 

Cliquez sur la case On.

Lorsque la case est cochée, vous entendez immédiatement le signal de test via le canal 
de balayage sélectionné.

 

Remarque :  

 

le niveau du signal de test est déterminé par le paramètre Sweep Level.
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Enregistrement audio dans l’Utilitaire de réponse d’impulsion

 

Après avoir sélectionné vos assignations matérielles et configuré le moniteur ainsi que le 
générateur de balayage sinusoïdal, vous pouvez commencer à enregistrer vos pistes audio.

 

L’enregistrement dans l’Utilitaire de réponse d’impulsion se fait en trois étapes :
1

 

Sélectionnez une piste audio dans la section Inputs/Tracks.

 

2

 

Configurez la piste audio pour l’enregistrement.

 

3

 

Répétez cette étape pour chaque piste requise par le format choisi.

 

4

 

Cliquez sur le bouton Sweep/Record pour lancer l’enregistrement.

Si vous utilisez le générateur de balayage, vous entendrez le balayage d’onde sinusoïdale 
sur toute sa plage de fréquences. L’Utilitaire de réponse d’impulsion enregistre le résultat 
sur la ou les pistes audio sélectionnées. 

Si vous avez désactivé le générateur de balayage, cliquez sur Enregistrement et tirez un 
coup de pistolet de starter. L’Utilitaire de réponse d’impulsion enregistre la réponse 
d’impulsion résultante sur la piste audio sélectionnée. 

 

Pour sélectionner une piste audio, effectuez l’une des opérations suivantes :
m

 

Cliquez dans la bande de piste souhaitée.

m

 

Utilisez les touches Flèche vers le haut et Flèche vers le bas pour parcourir la liste des pistes.

 

Configuration des pistes audio pour l’enregistrement

 

La section Inputs/Tracks affiche automatiquement le nombre de pistes requis pour l’enre-
gistrement de la réponse d’impulsion en fonction de vos sélections dans la zone de dialo-
gue « New Impulse Response Project ». Chaque bande de piste de la section Inputs/Tracks 
présente un certain nombre de paramètres. Certains d’entre eux sont automatiquement 
configurés par l’Utilitaire de réponse d’impulsion, les autres doivent être définis par l’utilisa-
teur avant l’enregistrement.

 

Paramètres des pistes
Â

 

Menu Speaker Position :

 

  permet de choisir l’étiquette de position du haut-parleur pour 
la piste sélectionnée. L’Utilitaire de réponse d’impulsion et Space Designer utilisent tous 
deux ces étiquettes pour identifier et traiter les fichiers audio composant une réponse 
d’impulsion stéréo ou Surround multicanal. L’Utilitaire de réponse d’impulsion définit 
automatiquement l’étiquette de position du haut-parleur pour chaque piste, mais vous 
pouvez en sélectionner une autre (parmi celles disponibles dans le format de réponse 
d’impulsion actuel) si vous le souhaitez.
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Â

 

Menu Mic Position :

 

  permet de choisir l’étiquette de position du micro pour la piste sélec-
tionnée. L’Utilitaire de réponse d’impulsion et Space Designer utilisent tous deux ces éti-
quettes pour identifier, et traiter, les fichiers audio composant une réponse d’impulsion 
stéréo ou Surround multicanal. L’Utilitaire de réponse d’impulsion définit automatique-
ment l’étiquette de position du micro pour chaque piste, mais vous pouvez en sélection-
ner une autre (parmi celles disponibles dans le format de réponse d’impulsion actuel) si 
vous le souhaitez.

Â

 

Menu Input :

 

  permet de définir l’entrée physique de chaque piste. Veillez à sélectionner la 
bonne entrée avant l’enregistrement.

Â Bouton S[olo] :  cliquez dessus pour activer ou désactiver le mode Solo pour la piste sélec-
tionnée. Lorsque le bouton Solo est activé (jaune), le signal d’entrée est acheminé vers la 
section du moniteur et le niveau d’entrée est affiché dans le VUmètre (voir « VU Meter » 
ci-dessous). Vous ne pouvez mettre qu’une seule piste à la fois en mode Solo.

Â Bouton R[ecord-Enable] :  met la piste sélectionnée en mode « Prêt pour 
l’enregistrement ». Le bouton E devient rouge lorsqu’il est activé. Le fait de cliquer 
sur ce bouton active également le bouton Solo pour la piste sélectionnée, ce qui 
vous permet de contrôler le signal d’entrée avant l’enregistrement. Vous pouvez 
activer plusieurs pistes à la fois pour un enregistrement multicanal. Lorsque vous 
cliquez sur le bouton Sweep/Record, un enregistrement est réalisé sur 
toutes les pistes activées pour l’enregistrement.

Â Bouton L[ock] :  verrouille les paramètres Sweep Length et Reverb Time pour garantir 
que tous les enregistrements suivants utilisent les mêmes valeurs.

Â Peak :  affiche la valeur du niveau de crête en dB. Si le niveau vient à dépasser 0 dB, 
la valeur de crête est conservée jusqu’à ce qu’elle soit effacée. Le fait de cliquer sur 
l’en-tête de la colonne Crête réinitialise la mesure Crête de toutes les pistes.

Â Level :  affiche le VU Meter de chaque piste. Ce VU Meter affichent toujours 
le niveau actuel des entrées physiques.

Mode de verrouillage et générateur de balayage
Lorsqu’une piste est verrouillée, les paramètres du générateur de balayage le sont égale-
ment. Cela permet de garantir que tous les enregistrements suivants utilisent les mêmes 
réglages de balayage. Chaque piste doit en effet utiliser un balayage sinusoïdal identique 
pour pouvoir produire une réponse d’impulsion multicanal avec une phase cohérente et 
une sonorité précise.
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VU Meter
L’Utilitaire de réponse d’impulsion offre un VU Meter mesurant soit le niveau du signal au 
niveau de l’entrée de la piste (mise en mode Solo), soit la sortie du générateur de 
balayage. Pendant la lecture de l’audio enregistré, le VU Meter affiche le niveau de la piste 
sélectionnée. Un message d’état affiché sous le VU Meter indique son mode de fonction-
nement actuel. L’échelle du VU Meter va de 0 à 100 %, où 100 % représente 0 dB.

Enregistrement
Après avoir configuré et activé les pistes souhaitées pour l’enregistrement, cliquez sur 
le bouton Sweep/Record. Si vous utilisez le générateur de balayage, le bouton indique 
« Sweep ». Si vous n’utilisez pas le générateur de balayage (paramètre Longueur du 
balayage réglé sur Off ), le bouton indique « Record ».
Â Le fait de cliquer sur Sweep lance automatiquement l’enregistrement et génère 

le balayage sinusoïdal (en utilisant les paramètres du générateur de balayage choisis). 
Le VU Meter affiche automatiquement la sortie du générateur de balayage.

Â Le fait de cliquer sur Record lance automatiquement l’enregistrement. Tirez un coup 
de pistolet de starter et l’Utilitaire de réponse d’impulsion enregistrera 
la réponse d’impulsion.

L’enregistrement se poursuit jusqu’à ce que la durée définie pour le balayage sinusoïdal 
(si le générateur de balayage est utilisé) et le paramètre Reverb Time soit écoulée. Il 
s’arrête automatiquement. Vous pouvez également l’arrêter manuellement 
en cliquant sur le bouton Sweep/Record.

Remarque :  le bouton Sweep/Record est désactivé si aucune piste n’est 
activée pour l’enregistrement.

Enregistrement automatique des projets
L’Utilitaire de réponse d’impulsion enregistre l’audio dans la mémoire RAM plutôt que 
sur le disque dur. Cela signifie que l’audio enregistré n’est pas sauvegardé tant 
que vous n’avez pas enregistré votre projet.

Pour plus de commodité, l’Utilitaire de réponse d’impulsion enregistre automatiquement 
votre projet sur disque après chaque enregistrement audio. 
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Si vous n’avez pas encore enregistré votre projet, la zone de dialogue Enregistrer s’ouvre 
pour vous permettre de lui attribuer un nom et de choisir un emplacement sur votre dis-
que dur. Si vous l’avez déjà enregistré auparavant, l’enregistrement se fait automatique-
ment. Voir « Enregistrement et ouverture des projets » à la page 22 pour en savoir plus.

Déconvolution de votre réponse d’impulsion
Si vous utilisez le générateur de balayage, vous devez déconvoluer vos enregistrements 
audio pour pouvoir les utiliser comme réponse d’impulsion. 

Pour déconvoluer vos pistes audio, effectuez l’une des opérations suivantes :
m Cliquez sur le bouton Deconvolve.

m Choisissez Edit > Deconvolve (ou appuyez sur Maj + Commande + D).

Après la déconvolution, vos pistes audio ne forment plus qu’une seule et même réponse 
d’impulsion que vous pouvez écouter, éditer et convertir en fichier de réglage .sdir.

Remarque :  bien qu’il soit possible de déconvoluer chaque piste audio après son enregistre-
ment, cela ne présente aucun intérêt. Il est beaucoup plus efficace d’attendre que toutes 
les pistes soient enregistrées avant de les déconvoluer.

Édition et écoute de votre réponse d’impulsion
Après avoir enregistré (ou déconvolué vos pistes audio en) une réponse d’impulsion, 
vous pouvez utiliser la zone Editing pour la « retoucher ». Vous pouvez également utiliser 
la fenêtre Audition IR pour écouter le résultat obtenu lorsqu’elle est appliquée à un fichier 
audio test.

Édition de votre réponse d’impulsion
Une fois vos pistes audio enregistrées, il se peut que vous constatiez trop de silence 
au début ou à la fin, qu’elles ne s’atténuent pas suffisamment tôt, etc. Pour corriger 
ces problèmes mineurs, l’Utilitaire de réponse d’impulsion vous permet de couper, de 
tronquer et d’appliquer un fondu à vos fichiers audio dans la zone Editing.
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Pour afficher un fichier audio dans la zone Editing :
m Sélectionnez le fichier audio. 

Il apparaît alors automatiquement dans la zone Editing. 

Vous pouvez choisir l’un des trois modes d’affichage disponibles dans la zone Editing :
Â Waveform :  affiche l’audio enregistré sous la forme d’une forme d’onde standard. 

L’axe horizontal affiche le temps écoulé. L’axe vertical affiche le niveau sonore sous 
forme de pourcentage.

Â Energy :  affiche la répartition de l’énergie acoustique dans le temps. L’axe horizontal 
affiche le temps écoulé. L’axe vertical affiche les niveaux sonores en dB.

Â Spectrogram :  affiche la répartition des fréquences dans le temps. L’axe horizontal 
affiche le temps écoulé. L’axe vertical affiche les fréquences, qui sont colorées en 
fonction de la plage de décibels. La légende des couleurs dans le coin supérieur droit 
de la zone Editing indique le système de couleurs utilisé. 

Ces modes d’affichage vous permettent d’analyser efficacement vos formes d’onde 
et d’identifier facilement les parties à couper ou à tronquer, ou celles nécessitant un 
fondu. Le mode Spectrogramme, qui affiche simultanément la fréquence, le niveau et 
le temps, est particulièrement bien adapté à une analyse très détaillée de votre audio.
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Boutons de transport
La zone Editing contient deux boutons de transport :
Â Play :  lance ou arrête la lecture de la piste audio sélectionnée. Vous pouvez également 

utiliser la barre d’espace à cette fin.
Â Cycle :  active/désactive le mode Cycle. Lorsque ce mode est activé (bouton assombri), 

la piste sélectionnée est lue en boucle.

Fonctions d’édition
L’Utilitaire de réponse d’impulsion offre trois fonctions d’édition utilisables à l’aide des 
deux boutons d’édition situés en haut à gauche de la fenêtre Editing :  Cut, Crop, et Fade. 

Toutes les fonctions d’édition sont utilisables de la même manière :
1 Cliquez et faites glisser le pointeur sur une portion de l’audio dans la zone Editing. 

2 Cliquez sur le bouton de la fonction d’édition de votre choix.

Â Crop :  si vous effectuez une sélection n’incluant ni le début ni la fin de l’audio, 
le bouton d’édition de gauche active la fonction Crop. Le fait de cliquer sur ce bouton 
supprime l’audio se trouvant à droite et à gauche de votre sélection, sans affecter 
l’audio sélectionné. Vous pouvez également choisir Editing > Crop (ou appuyer sur 
Commande + X) à cette fin.

Â Cut :  si vous effectuez une sélection incluant le début ou la fin de l’audio, le bouton 
d’édition de gauche active la fonction Cut. Le fait de cliquer sur ce bouton supprime la 
sélection sans affecter l’audio non sélectionné. Vous pouvez également choisir 
Editing > Cut (ou appuyer sur Commande + X) à cette fin.

Â Fade :  si vous effectuez une sélection incluant le début ou la fin de l’audio, vous pou-
vez sélectionner la fonction Fade. Le fait de cliquer sur ce bouton crée un fondu pro-
gressif sur toute la longueur de la zone sélectionnée. Vous pouvez également choisir 
Editing > Fade (ou appuyer sur Commande + F).

Remarque :  pour préserver la cohérence de phase entre toutes les pistes de votre réponse 
d’impulsion, les opérations d’édition sont appliquées de la même manière à toutes les pis-
tes. Pour que votre réponse d’impulsion ne comporte aucune piste éditée de manière diffé-
rente, vous ne pouvez plus enregistrer d’autres pistes après une session d’édition.



19

Écoute de votre réponse d’impulsion
Pour vous faire une idée du son de votre réponse d’impulsion lorsqu’elle sera utilisée 
dans Space Designer, vous devez pouvoir l’écouter en contexte. L’Utilitaire de réponse 
d’impulsion inclut à cette fin une fenêtre Écoute dans laquelle vous pouvez convoluer la 
réponse d’impulsion chargée avec des fichiers audio test. La fenêtre Audition est divisée 
en trois sections :  la zone Impulse Response, la zone Monitor et la zone Audio Test File.

L’Utilitaire de réponse d’impulsion permet de charger/d’utiliser jusqu’à cinq fichiers 
audio comme sources lors de l’écoute de votre réponse d’impulsion. La fenêtre Audition 
comprend également quatre fichiers sources de test intégrés.

Pour ouvrir la fenêtre Audition :
m Cliquez sur le bouton Audition IR.

La fenêtre Audition s’ouvre. Toutes les fonctions d’édition sont désactivées lorsque 
cette fenêtre est ouverte.

La fenêtre Audition comporte les paramètres suivants :
Â Case Enable :  permet d’activer ou de désactiver les différents enregistrements de 

réponse d’impulsion. Utilisez ces cases pour sélectionner le ou les fichiers à écouter.
Â Étiquette Input ID :  identifie le fichier de réponse d’impulsion à l’aide de ses positions 

de haut-parleur > micro.
Â Menu Output Channel  :  permet de sélectionner le canal de sortie physique utilisé 

pour la lecture de la réponse d’impulsion sélectionnée.
Â Champ Mix :  détermine le rapport signal source test sec/signal d’effet.
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Â Champ Monitor Level :  permet de définir le niveau d’écoute global.
Â Boutons Test Audio File :  permet de lire l’un des quatre fichiers audio sources 

de test intégrés.
Â Boutons Ouvrir :  cliquez dessus pour charger un fichier audio à utiliser comme source 

de test. Vous pouvez utiliser n’importe quel fichier audio non compressé.
Â Boutons Play :  cliquez dessus pour lire le fichier audio sélectionné combiné avec 

le ou les fichiers de réponse d’impulsion activés.

Réponses d’impulsion en format B
L’apparence de la fenêtre Audition change légèrement lorsque vous utilisez une 
réponse d’impulsion en format B. La fenêtre Audition du format B supprime le paramè-
tre Output Channel de la zone Piste et comprend une zone Loudspeaker :

La zone Loudspeaker comprend les paramètres suivants :
Â Number of Loudspeakers :  permet de définir le nombre de haut-parleurs utilisés par 

l’Utilitaire de réponse d’impulsion pour décoder la réponse d’impulsion. Cliquez sur les 
flèches pour augmenter ou diminuer le nombre de haut-parleurs, ou double-cliquez 
sur le nombre affiché et saisissez une nouvelle valeur.

Â Loudspeaker Angle :  permet de configurer l’angle de chaque haut-parleur. Le déco-
dage du format B prend ce paramètre en compte pour recréer l’espace enregistré.

Â Output Channel :  permet de définir le canal de sortie physique du haut-parleur sélec-
tionné.
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Création d’un réglage Space Designer
Lorsque vous êtes satisfait de votre réponse d’impulsion, vous pouvez générer un fichier 
.sdir, ainsi qu’un réglage de module. Une fois cette opération réalisée, vous pourrez utiliser 
votre nouvelle réponse d’impulsion dans Space Designer.

Pour créer un réglage Space Designer, effectuez l’une des opérations suivantes :
m Cliquez sur le bouton Create Space Designer Setting.

m Choisissez File > Create Space Designer Setting.

L’Utilitaire de réponse d’impulsion génère un fichier .sdir de votre réponse d’impulsion et 
l’enregistre dans le répertoire suivant :  ~/Bibliothèque/Application Support/Logic/Impulse 
Responses. 

Il génère également un fichier de réglage de module pour votre réponse d’impulsion et 
l’enregistre dans le répertoire suivant :  ~/Bibliothèque/Application Support/Logic/
Plug-In Settings/Space Designer.

La prochaine fois que vous ouvrirez Logic, votre nouvelle réponse d’impulsion 
sera disponible dans la Bibliothèque, ainsi que dans l’interface de Space Designer.
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Enregistrement et ouverture des projets
Comme indiqué précédemment, l’Utilitaire de réponse d’impulsion enregistre automatique-
ment votre projet dès que vous effectuez un enregistrement audio. Vous pouvez toutefois 
l’enregistrer manuellement à tout moment. Vous pouvez également ouvrir un projet pré-
cédemment enregistré ou revenir à la dernière version enregistrée du projet ouvert.

Pour enregistrer votre projet en utilisant son nom et son emplacement actuels :
m Choisissez File > Save Project (ou appuyez sur Commande + S) pour enregistrer votre pro-

jet de réponse d’impulsion sous son nom actuel dans son emplacement actuel.

Pour enregistrer votre projet en utilisant un nouveau nom ou un nouvel emplacement :
m Choisissez File > Save As (ou appuyez sur Commande + Maj + S).

Le fichier de projet de réponse d’impulsion est un paquet Mac OS X contenant 
tous les fichiers associés au projet.

Ouverture des projets
Si vous souhaitez poursuivre votre travail sur un projet précédemment enregistré, 
vous devez d’abord l’ouvrir. 

Pour ouvrir un projet, effectuez l’une des opérations suivantes :
m Choisissez File > Open Project (ou appuyez sur Commande + O), puis recherchez votre 

fichier de projet.

m Choisissez File > Open Recent pour ouvrir un menu hiérarchique des fichiers de projet 
récemment ouverts.

Retour à la version enregistrée
Si vous n’êtes pas satisfait des modifications ou des enregistrements effectués dans 
le projet en cours et que vous avez déjà enregistré ce dernier, vous pouvez utiliser 
la commande File > Revert to Saved. Cela permet de revenir à la dernière version 
enregistrée du projet.

Remarque :  lorsque vous utilisez la commande Revert to Saved, vous perdez toutes 
les modifications non enregistrées.
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Recommandations relatives aux micros et haut-parleurs
La réponse d’impulsion d’un espace n’est jamais uniquement la réponse d’impulsion de 
cet espace. La réponse d’impulsion enregistrée est toujours la réponse de l’ensemble du 
système, c’est-à-dire de chaque élément de l’équipement que vous utilisez pour réaliser 
vos enregistrements. Cela inclut, dans l’ordre du trajet du signal :  le convertisseur numé-
rique-analogique, l’amplificateur et les haut-parleurs (ou les haut-parleurs amplifiés), 
les caractéristiques de la pièce, le ou les micros et, enfin, le préamplificateur du micro 
et le convertisseur analogique-numérique. Par conséquent, avant de quitter votre studio 
pour aller enregistrer la réponse d’impulsion d’un espace, vous devez penser à l’équipe-
ment que vous allez emporter. De nos jours, même les convertisseurs bon marché 
offrent une qualité acceptable, votre attention devra donc se porter sur la sélection 
des haut-parleurs et des micros.

Recommandations pour la sélection des micros 
et des haut-parleurs
Il n’existe aucune règle quant à la marque de micro ou de haut-parleur qui permettra 
d’obtenir la meilleure réponse d’impulsion. Un bon point de départ consiste à utiliser des 
haut-parleurs et des micros ayant une réponse linéaire (ce qui signifie qu’ils produisent un 
signal égal à toutes les fréquences). Vous trouverez des micros et des haut-parleurs offrant 
des réponses relativement linéaires à pratiquement tous les prix. Les micros à lampe, géné-
ralement appréciés pour la « couleur » qu’ils ajoutent au signal, ne constituent pas nécessai-
rement la meilleure option pour l’enregistrement de réponses d’impulsion. Les micros 
utilisés comme micros d’ambiance sont généralement de bons candidats. 
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Recommandations pour le positionnement des haut-parleurs 
et des micros
L’endroit où vous placez vos haut-parleurs et vos micros dans l’espace d’enregistrement 
a un impact important sur les échos et les réflexions particuliers capturés par votre réponse 
d’impulsion. Il va sans dire que la créativité est la clé du succès et que tout repose sur 
l’expérimentation. 

Il existe toutefois quelques recommandations et principes généraux qui pourront vous 
aider à prendre un bon départ.

Recommandation générale pour le positionnement dans les environnements présentant 
des sols durs faits de matériaux tels que le béton :  il se peut qu’un son strident soit enregis-
tré au début de votre réponse d’impulsion. Ce son est en fait le balayage sinusoïdal 
généré transmis par le sol et capté par le micro. Le son se propage en effet beaucoup plus 
vite dans les sols et le béton que dans l’air, ce qui produit une réponse pré-impulsionnelle 
avant celle que vous souhaitez enregistrer. Pour éviter ce problème potentiel, vous pouvez 
utiliser des pieds de batterie de « studio » et des suspensions de micro spéciaux dotées de 
puissants absorbeurs acoustiques intégrés. Si vous ne pouvez pas emmener de pieds de 
batterie ou si vous n’avez pas les moyens d’acheter des supports de micro onéreux, essayez 
de placer un tapis épais sous les haut-parleurs et le ou les pieds de micro. 

Vous trouverez ci-dessous certaines approches spécifiques que vous pouvez essayer lors de 
la création de réponses d’impulsion. Gardez à l’esprit qu’il ne s’agit que de suggestions. Il 
n’existe aucune règle quant à la distance à laquelle les haut-parleurs doivent être éloignés 
de la batterie de micros, aux angles optimaux, à la distance idéale entre les haut-parleurs et 
les micros, etc. Vous pouvez essayer différentes techniques et différents positionnements 
pour trouver la configuration idéale. La création de réponses d’impulsion est un art !

Approche de l’auditeur virtuel
Il s’agit sans doute de la technique la plus courante pour positionner les haut-parleurs 
et les micros en vue de créer des réponses d’impulsion. L’objectif est de capturer 
l’effet des échos et des réflexions produits par tout l’espace, tels qu’ils sont entendus 
à la position d’écoute. Dans cette approche, les haut-parleurs sont installés sur les côtés 
de la pièce et le micro est placé à la position d’écoute. 
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La réponse d’impulsion résultante (lorsque vous l’utilisez plus tard dans Space Designer 
pour ajouter de la réverbération à votre signal) doit donner l’impression que votre audio 
provient des différentes positions de haut-parleur dans l’« espace ». Il n’est pas nécessaire 
d’avoir plusieurs micros pour cette méthode ; un seul micro peut être dirigé tour à tour 
vers chacun des haut-parleurs et plusieurs enregistrements audio peuvent être réalisés 
depuis le même emplacement. L’image ci-dessous illustre l’approche de l’auditeur virtuel 
pour positionner cinq haut-parleurs (pour une réponse d’impulsion Surround à cinq 
canaux), avec un micro placé au centre de l’espace.

Cette méthode permet de donner l’impression que le signal audio est complètement 
immergé dans l’espace simulé.

C
RL

RsLs Système 
de micros 
Surround
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Approche de l’auralisation
L’auralisation est une autre méthode courante pour le positionnement des haut-parleurs 
et des micros dans un espace. Cette technique consiste à essayer de capturer les réflexions 
depuis la position de l’interprète. Installez un ou plusieurs haut-parleurs à la position de 
l’interprète (ou d’une autre source audio) et placez un micro à la position d’écoute. La 
réponse d’impulsion résultante (lorsque vous l’utilisez dans Space Designer) doit donner 
l’impression que votre audio provient de l’endroit précis où les haut-parleurs sont position-
nés. Vous pouvez utiliser la technique de l’auralisation pour créer, par exemple, une réponse 
d’impulsion stéréo d’une scène particulière. Lorsque vous utilisez cette réponse d’impul-
sion dans Space Designer, votre audio doit donner l’impression qu’il provient de cette 
scène. L’image ci-dessous illustre l’utilisation de la technique de l’auralisation pour posi-
tionner vos haut-parleurs et vos micros en vue de créer une réponse d’impulsion stéréo 
véritable.

Pour capturer une réponse d’impulsion Surround donnant l’impression d’être « dans le 
public » d’un espace, installez deux haut-parleurs à la position de l’interprète comme 
illustré ci-dessus, mais placez un ensemble Surround de micros autour de la pièce. Cela 
permet de créer l’impression (et l’effet) réaliste d’être « dans le public », comme si l’inter-
prétation avait lieu face à vous. Vous pouvez ainsi créer un effet Surround à partir d’un 
enregistrement stéréo en direct.

Scène

Public

L R
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Approche de la chambre d’échos virtuelle
Une bonne alternative à l’approche de l’auralisation consiste à placer vos haut-parleurs et 
vos micros de façon à créer un espace virtuel ressemblant à une chambre d’échos réelle. 
Pour créer ce genre de réponse d’impulsion, orientez les haut-parleurs vers deux coins de 
la pièce et les micros vers les coins opposés. C’est ainsi que seraient positionnés les 
micros dans une chambre d’échos réelle. Cela élimine tout chemin direct entre le haut-
parleur et le micro et permet de capturer davantage de réflexions. L’image ci-dessous illus-
tre la façon dont vous pouvez positionner deux haut-parleurs et deux micros pour créer 
une réponse d’impulsion stéréo à l’aide de cette approche de chambre d’échos virtuelle.

Vous pouvez ainsi mixer la réverbération avec le signal sec sans problèmes d’annulation 
de phase causés par les premières réflexions ou les signaux directs. Cette approche fonc-
tionne particulièrement bien si vous souhaitez conserver un signal pratiquement sec, non 
altéré ni coloré par la réverbération, tout en ajoutant une pointe de réverbération haute 
fidélité à votre audio.

Vous pouvez également utiliser cette méthode pour créer des réverbérations Surround 
ou à plusieurs canaux. Le principal concept à garder à l’esprit est que les haut-parleurs 
doivent être orientés vers le mur afin d’éliminer tout chemin direct entre ces derniers et 
les micros. L’illustration ci-dessous présente une disposition possible pour une cham-
bre de réverbération à cinq canaux. Les haut-parleurs, positionnés en cercle, sont diri-
gés vers les murs, et l’ensemble de micros est placé au centre du cercle. 
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Enregistrement de réponses d’impulsion de haut-parleurs de 
guitare et de périphériques matériels
Vous n’êtes pas limité à la création de réponses d’impulsion de pièces et d’espaces. 
Vous pouvez créer une réponse d’impulsion de tout appareil permettant de lire un 
balayage sinusoïdal à large bande (et d’enregistrer le résultat). Voici deux exemples : 
les enceintes acoustiques de guitare et les périphériques de traitement matériels tels 
que les égaliseurs à lampes et les unités de réverbération.

Le son d’une guitare électrique émis par un amplificateur de guitare est très influencé par 
la réponse en fréquence et la couleur de l’enceinte acoustique. Si vous créez une réponse 
d’impulsion d’une enceinte acoustique de guitare et que vous combinez ensuite un 
signal d’amplificateur de guitare direct avec cette réponse d’impulsion dans Space Desi-
gner (avec l’effet réglé à 100 %), le signal direct sonnera comme s’il était émis par l’enceinte.

Vous devez toujours disposer d’un micro et d’une interface audio pour créer une réponse 
d’impulsion d’une enceinte acoustique de guitare, mais vous n’avez pas besoin d’un 
haut-parleur de monitoring supplémentaire pour le balayage sinusoïdal à large bande 
dans la mesure où celui-ci est lu via le haut-parleur/l’amplificateur de guitare lui-même. 
Si votre amplificateur de guitare est doté d’un retour d’effets, vous pouvez l’utiliser pour 
créer la réponse d’impulsion. S’il en est dépourvu, vous pouvez utiliser un boîtier de 
« ré-amplification » (qui augmente l’impédance de la sortie de ligne de votre interface 
audio au niveau requis par l’entrée de votre amplificateur de guitare) ou un amplificateur 
de niveau de ligne en lieu et place de votre amplificateur de guitare (pour amplifier le 
balayage sinusoïdal via l’enceinte acoustique de guitare). 

Vous pouvez tester plusieurs positionnements de micro tout comme vous le feriez pour 
la prise de son d’un espace physique, mais sachez que le positionnement le plus courant 
est la « prise de son de proximité », qui consiste à placer votre micro très près du haut-
parleur (jusqu’à 2,5 cm). L’illustration ci-dessous montre comment vous pouvez installer 
votre enceinte acoustique de guitare pour créer votre réponse d’impulsion.

Ampli de guitare 
avec micro

OrdinateurInterface audio
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Imaginons que vous souhaitiez créer une réponse d’impulsion de votre préamplifica-
teur de micro à lampe favori pour pouvoir appliquer sa couleur unique à votre audio. 
Vous pourriez ainsi combiner un signal avec cette réponse d’impulsion dans Space 
Designer (avec l’effet réglé à 100 %) en vue d’ajouter la couleur de votre préamplifica-
teur de micro à ce signal. 

Ce scénario ne nécessite ni haut-parleurs ni micros. Il suffit de brancher la sortie de 
votre interface audio sur l’entrée de votre périphérique matériel et de lire le balayage 
sinusoïdal via ce dernier. Branchez ensuite la sortie de votre périphérique matériel sur 
l’entrée de votre interface audio pour enregistrer le signal dans l’Utilitaire de réponse 
d’impulsion. Vous pouvez utiliser cette méthode pour créer des réponses d’impulsion 
d’unités de réverbération, d’unités multi-effets ou encore d’égaliseurs matériels.

Vous devez être prudent lors de la création de réponses d’impulsion de périphériques 
d’effets matériels incluant des effets de modulation. Les modulations telles que les roto-
phaseurs, les chorus, etc. interfèrent avec le balayage sinusoïdal lui-même, ce qui rend 
la déconvolution difficile, voire impossible. Cela vaut également pour certaines unités 
de réverbération telles que les périphériques de réverbération matériels Lexicon classiques, 
dans lesquels les queues de réverbération sont modulées. Dans ces cas, il est préférable 
d’envoyer une impulsion enregistrée (telle qu’un pic ou un coup de feu) au périphérique 
d’effets matériel plutôt qu’un balayage sinusoïdal.

Encodage Surround au format B
Le format B est une technique spéciale d’encodage d’informations spatiales. Il représente 
l’espace à l’aide de quatre flux audio :  un pour capturer la pression acoustique (W) et trois 
pour capturer les coordonnées X (avant vers arrière), Y (gauche à droite) et Z (haut vers bas) 
de la pièce. L’illustration ci-dessous montre comment ces quatre flux audio interagissent 
entre eux pour créer une image spatiale en trois dimensions.
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Space Designer peut décoder et convoluer ces quatre flux audio en réverbérations dans 
tous les formats Surround pris en charge. Space Designer offre une bibliothèque complète 
de réponses d’impulsion au format B utilisant les quatre flux (W, X, Y et Z). Dans la 
mesure où les réponses d’impulsion n’utilisent pas les informations de l’axe Z, l’Utilitaire de 
réponse d’impulsion n’enregistre et n’encode que les informations des signaux W, X et Y, 
ce qui permet d’économiser de l’espace disque et les ressources de l’unité centrale. L’Uti-
litaire de réponse d’impulsion permet d’encoder tous les formats de réponse d’impul-
sion Surround pris en charge au format B.

Avantages de l’encodage Surround au format B
L’un des avantages du format B est qu’il permet de capturer une image Surround avec 
moins de fichiers audio. En temps normal, vous devez enregistrer chaque position de 
haut-parleur depuis chaque position de micro pour enregistrer correctement toutes les 
informations Surround. Avec le format B, ces quatre (ou trois, dans l’Utilitaire de réponse 
d’impulsion) flux audio sont tout ce dont vous avez besoin pour capturer l’audio de cha-
que haut-parleur.

Imaginons par exemple que vous utilisiez une installation à cinq canaux et que vous souhai-
tiez créer une réponse d’impulsion à cinq canaux à l’aide de l’Utilitaire de réponse d’impul-
sion. Avec les méthodes classiques, vous devriez enregistrer les cinq haut-parleurs 
depuis les cinq positions de micro, ce qui générerait 25 fichiers audio. Si vous choisissez de 
créer un projet de réponse d’impulsion à cinq canaux au format B, vous n’aurez à enregis-
trer que 15 fichiers audio, soit trois enregistrements audio (W, X et Y) pour chacune des cinq 
positions de haut-parleur. Comme vous pouvez le constater, les réponses d’impulsion Sur-
round encodées au format B nécessitent beaucoup moins de fichiers audio, ce qui signifie 
moins d’espace disque, et également moins de mémoire RAM et de cycles d’unité centrale 
lors du décodage dans Space Designer.

Un autre avantage de l’encodage au format B est la cohérence de phase lors de l’utilisation 
simultanée de plusieurs micros. Lorsque vous utilisez plusieurs micros, les différences de 
temps nécessaire au son pour atteindre chacun d’eux peuvent produire des annulations 
de phase et des déphasages, ce qui peut affecter la qualité de votre réponse d’impulsion. 
Dans la mesure où le point de référence est toujours le même avec l’encodage au 
format B, il n’y a pas de problèmes de phase, même lorsque vous utilisez plusieurs micros 
pour enregistrer votre réponse d’impulsion.
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Micros recommandés pour l’enregistrement au format B
Les meilleurs micros pour l’enregistrement au format B sont probablement les micros 
Surround de marque SoundField. Ces micros contiennent toutes les capsules dont vous 
avez besoin pour réaliser un enregistrement de référence complet au format B en une seule 
prise et incluent les composants matériels nécessaires à l’envoi des flux d’axe distincts aux 
différentes pistes de l’Utilitaire de réponse d’impulsion. Il suffit de faire pivoter le micro une 
fois en direction de chaque position de haut-parleur et le matériel du micro et de traite-
ment s’occupe du reste. Pour les personnes ne pouvant pas investir dans des micros 
SoundField, l’Utilitaire de réponse d’impulsion offre d’autres options de micro pour 
l’enregistrement au format B.

La capture du signal W (pression acoustique) nécessite un micro omnidirectionnel. La 
capture des signaux d’axe X et Y nécessite un micro bidirectionnel (pour capturer le signal 
à l’avant et à l’arrière du micro). Ainsi, vous pouvez enregistrer chaque position de haut-
parleur en une seule prise à l’aide de deux micros bidirectionnels, l’un étant dirigé direc-
tement vers la source du haut-parleur (X) et l’autre placé perpendiculairement (Y), et d’un 
micro omnidirectionnel pour la pression acoustique (W). Veillez à positionner les micros de 
façon à ce que leurs capsules soient aussi proches que possible l’une de l’autre, l’idéal étant 
d’avoir un point de référence unique compact pour chaque position de haut-parleur.

Vous devrez faire pivoter chaque micro bidirectionnel vers chaque position de haut-parleur. 
Il n’est pas nécessaire de déplacer le micro omnidirectionnel car sa capsule capte le son 
à 360 degrés.

Même si votre budget est trop limité pour acquérir trois micros différents, vous pouvez 
toujours créer des réponses d’impulsion au format B en enregistrant chaque flux audio 
séparément dans l’Utilitaire de réponse d’impulsion. Il vous suffit pour cela de disposer 
d’un micro permettant de basculer entre une courbe omnidirectionnelle et une courbe 
bidirectionnelle. De nombreux micros performants (à tous les prix) offrent cette possibi-
lité. Vous devrez souvent basculer d’une courbe de directivité à une autre et faire pivoter 
les micros, mais cela est faisable.

Guide d’initiation
Cette rubrique vous guide tout au long du processus de création d’une réponse d’impul-
sion, de la création du projet à la génération du réglage Space Designer final. Pour ce guide 
d’initiation, imaginons que vous ayez l’autorisation d’enregistrer dans une salle de concert 
locale ayant une acoustique particulièrement bonne. Dans la mesure où cette opportunité 
ne se présentera probablement plus jamais, vous avez décidé d’enregistrer une réponse 
d’impulsion Surround à cinq canaux distincts.
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Création d’une réponse d’impulsion Surround à cinq canaux
Suivez les étapes présentées ci-dessous pour créer une réponse d’impulsion Surround à 
cinq canaux distincts. 

Étape 1 :  préparation :  installation des micros et des haut-parleurs
La première étape consiste à installer vos haut-parleurs et vos micros. Imaginons que vous 
ayez décidé d’utiliser l’approche de l’auditeur virtuel, qui nécessite cinq haut-parleurs et au 
moins un micro placé au centre que vous pouvez orienter tour à tour vers chacun des haut-
parleurs. Vous devriez idéalement disposer de cinq moniteurs amplifiés identiques. Cela 
vous fera gagner du temps lors de l’enregistrement et vous permettra de voir tous les haut-
parleurs à la fois, de vous assurer qu’ils sont tous à la même distance des coins et des 
murs, etc. Une fois tous les haut-parleurs positionnés, vous devez installer votre micro au 
centre de la salle. Vérifiez que tous les composants sont correctement connectés à votre 
interface audio. 

Étape 2 :  création d’un projet
L’étape suivante consiste à ouvrir l’Utilitaire de réponse d’impulsion et à créer un projet de 
réponse d’impulsion à cinq canaux. La zone de dialogueNew Impulse Response Project 
vous informe que ce format nécessite cinq positions de haut-parleur et de micro. Lorsque 
vous fermez la zone de dialogue, vingt-cinq pistes audio s’affichent dans la section Inputs/
Tracks, une pour chaque position de haut-parleur depuis chaque position de micro.

Étape 3 :  configuration des paramètres de l’Utilitaire de réponse d’impulsion
Orientez votre micro vers le haut-parleur à enregistrer (celui situé devant à gauche, par 
exemple). Configurez la section Monitor, le générateur de balayage et l’entrée pour la 
piste sélectionnée.

Étape 4 :  enregistrement
Activez la piste sélectionnée pour l’enregistrement, puis cliquez sur le bouton Sweep. 
L’Utilitaire de réponse d’impulsion vous invite à saisir un nom pour le nouveau projet et à 
l’enregistrer une fois le premier enregistrement terminé. 

Faites pivoter le micro vers la deuxième position Surround, activez la piste pour l’enregis-
trement, puis cliquez sur le bouton Sweep. Une fois l’enregistrement terminé, le projet est 
automatiquement enregistré en arrière-plan. Si vous le souhaitez, vous pouvez lire la piste 
dans la zone Editing pour contrôler l’enregistrement.

Répétez cette procédure vingt-trois fois de plus jusqu’à ce que vous ayez enregistré les 
vingt-cinq pistes audio nécessaires à la capture de toutes les combinaisons de positions 
de micro et de haut-parleur possibles.

Étape 5 :  déconvolution
Cliquez sur le bouton Deconvolve après avoir enregistré (et contrôlé) les fichiers audio 
pour chaque position. À ce stade, vous devriez enregistrer manuellement le projet.
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Étape 6 :  édition et écoute
Si vous constatez la présence de silence superflu au début ou à la fin de votre réponse 
d’impulsion, utilisez la zone Editing pour le supprimer. Utilisez la fenêtre Audition pour 
écouter des données de test combinées avec votre réponse d’impulsion pour vous assu-
rer que le résultat est bien celui escompté. Si le résultat n’est pas satisfaisant, continuez 
d’éditer votre réponse d’impulsion. Si vous n’êtes toujours pas satisfait du résultat, recom-
mencez à partir de l’étape deux ou trois.

Étape 7 :  création d’un réglage Space Designer
Lorsque vous êtes entièrement satisfait de votre réponse d’impulsion, vous pouvez cli-
quer sur Create Space Designer Setting. L’Utilitaire de réponse d’impulsion génère alors 
les fichiers .sdir et de réglages Space Designer. Votre nouvelle réponse d’impulsion sera 
disponible à la prochaine ouverture de Space Designer.

Ce processus de base est toujours le même, quel que soit le format de réponse 
d’impulsion ou l’approche de positionnement des micros et des haut-parleurs que vous 
choisissez. Il n’y a rien d’autre à faire !

Enregistrement d’une réponse d’impulsion à 5 canaux Mono 
vers Omni
La procédure ci-dessus décrit l’enregistrement d’une véritable réponse d’impulsion Sur-
round. Bien souvent, vous pouvez vous contenter d’enregistrer une seule position de 
haut-parleur pour créer une réponse d’impulsion mono/omni discrète. Les réponses 
d’impulsion mono/omni discrètes sont non seulement plus faciles et plus rapides 
à enregistrer, mais elles nécessitent également moins de puissance de l’unité centrale.

Pour créer une réponse d’impulsion à 5 canaux Mono vers Omni :
1 Choisissez le modèle de canaux Mono/Omni to 5 dans la zone de dialogue New Projects.

Vous verrez que les projets de réponse d’impulsion mono/omni discrète ne nécessitent 
qu’un seul haut-parleur.

2 Orientez votre haut-parleur vers le plafond ou vers un mur situé derrière.

3 Orientez votre micro vers la première position Surround :  devant à gauche, par exemple.

4 Enregistrez le balayage.

5 Répétez cette procédure pour toutes les autres positions de micro.
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